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Getting Started with Python Programming
Using Python with TI-Nspire™ products you can:

e add Python programs to TNS files

e create Python programs using templates

e interact and share data with other TI-Nspire™ apps

e interact with the Tl-Innovator™ Hub and Tl-Innovator™ Rover

The TI-Nspire™ Python implementation is based on MicroPython, which is a small
subset of the Python 3 standard library designed to run on microcontrollers. The
original MicroPython implementation has been adapted for use by TI.

Note: Some numeric answers may vary from the Calculator results due to differences in
the underlying math implementations.

Python is available on these TI-Nspire™ products:

Handhelds Desktop Software

TI-Nspire™ CX Il TI-Nspire™ CX Premium Teacher Software
TI-Nspire™ CX Il CAS TI-Nspire™ CX CAS Premium Teacher Software
TI-Nspire™ CX II-T TI-Nspire™ CX Student Software

TI-Nspire™ CX II-T CAS [ TI-Nspire™ CX CAS Student Software
TI-Nspire™ CX II-C
TI-Nspire™ CX II-C CAS

Note: In most cases, functionality is identical between the handheld and the software
views, but you may see some differences. This guide assumes that you are using the
handheld device or the Handheld view in the software.

Python Modules

TI-Nspire™ Python includes the following modules:

Standard Modules Tl Modules
Math (math) Tl PlotLib (ti_plotlib)
Random (random) Tl Hub (ti_hub)

Complex Math (cmath) [Tl Rover (ti_rover)
Time (time) Tl System (ti_system)
Tl Draw (ti_draw)

Tl Image (ti_image)

Note: If you have existing Python programs created in other Python development
environments, you may need to edit them to run on the TI-Nspire™ Python solution.
Modules may use different methods, arguments, and ordering of methods in a program
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compared to the Tl modules. In general, be aware of compatibility when using any
version of Python and Python modules.

When transferring Python programs from a non-Tl platform to a Tl platform OR from
one Tl product to another, remember:

e Programs that use core language features and standard libs (math, random, etc.)
can be ported without changes.

e Programs that use platform-specific libraries such as matplotlib for PC or Tl
modules will require edits before they will run on a different platform. This may be
true even between Tl platforms.

As with any version of Python, you will need to include imports to use any functions,
methods, or constants contained in a given module. For example, to execute the cos()
function from the math module, use the following commands:

>>>from math import *

>>>cos (0)
1.0

For a list of menus with their items and descriptions, please see the Menu Map section.
Installing a Python program as a module

To save your Python program as a module:

¢ Inthe Editor, select Actions > Install as Python Module.

¢ Inthe Shell, select Tools > Install as Python Module.
After selection, the following occurs:

e The Python syntax is checked.

e Thefile is saved and moved to the PyLib folder.

e Adialog appears confirming that the file has been installed as a module.
e Thefileis closed and the module is ready for use.

e The module name will be added to the More Modules menu with a from <module>
import * menu item.

If you plan to share this module with others, it is recommended that you follow these
guidelines:

e Store only one module per TNS file.

e The module name matches the name of TNS file (e.g. "my_program" module is in
the "my_program.tns" file).

e Add a Notes page before the Python Editor that describes the intent of the module,
the version, and the functions.

e Use the ver() function to display the version number of the module.

e (Optional) Add a help function to display the list of methods in the function.
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Python Workspaces

There are two workspaces for your Python programming: The Python Editor and the
Python Shell.

Python Editor Python Shell
e Create, edit and save Python e Run Python programs
programs e Convenient for testing small code
e Syntax highlighting and auto- fragments
indentation e Interaction with Shell history to select
¢ Inline prompts to guide with function previous inputs and outputs for re-
arguments use
e Tooltips to show range of valid . key lists global user variables
values defined in the last program ran in the

. key lists global user variables and given problem

functions defined in the current
program

e Keypad shortcuts

Note: Multiple Python programs and Shells can be added to a problem.

Python Editor
The Python Editor is where you can create, edit and save Python programs.
Adding a Python Editor page

To add a new Python Editor page in the current problem, press and select Add
Python > New.

1 Add Calculator

@ 2 Add Graphs
3 Add Geometry
B 4 Add Lists & Spreadsheet
@) 5 Add Data & Statistics

6 Add Notes

7 Add Vernier DataQuest™
@ 8 Add Widget
M 9 Add Program Editor y

(3 A Add Python

3 Shell

You can create a blank program, or you can select a template.

Blank program Template
*Dac

Elank Program

Math Calculations
New Random Simulations

Geometty Graphics
veme: [Sampled] | image Processing o
Tvpe: (B g 7] pet [Bank Frogam [ =

OK | Cancel OK  Cancel
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After creating the program, the Python Editor is displayed. If you selected a template,
the necessary import statements are automatically added (see below).

Note: You can have multiple programs in a single TNS file just like other apps. If the
Python program is intended to be used as a module, the TNS file can be saved in the
PyLib folder. That module can then be used in other programs and documents.

Math Calculations Random Simulations

D *Templates.py 5/5 3 *Templates.py 616
# Math Calculations #Random Simulations

from math import * from math import *

from random import *

Geometry Graphics Image Processing

0B *Doc w0 1] X [

) *Templates.py 5/5 [ *Templates.py 615
# Geometry Graphics #Image Processing

from ti_draw import * from ti_image import *

from ti_draw Import get_screen_dim

Plotting (x,y) & Text Data Sharing

@ *Templates.py 5/5 & *Templates.py 5/5
% Plotting () & Text [# Data Sharing

import ti_plotlib as ptt ffrom ti_system import *

Tl-Innovator Hub Project TI-Rover Coding

B *Templates.py 919 B *Templates.py 6/6)
#FHub Project #Rover Coding

from ti_hub import * import ti_rover as rv

from math import * from math import *

from time import sleep

from ti_plotlib import text_at,cls
from ti_system import get_key

Python Workspaces
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Opening a Python Program

To open an existing Python program, press and select Insert > Add Python > Open.
This will display a list of programs that have been saved in the TNS file.

If the Editor page used to create the program has been deleted, the program is still
available in the TNS file.

Working in the Python Editor

Pressing displays the Document Tools menu. With these menu options you can
add, move, and copy blocks of code for your program.

Document Tools menu

[l 1 Actions W
D 2 Run P 2 Run » 11
B 3 Edit » 3 Edit [ —
1. 4 Buil-ins ’ 1 SRCERNECRWEN  Functions »

¥+ 5 Math » [ 2 return ) Control  *

@ 6 Random 3 @ 6 Random 3 Ops »

147 TIPlottib  » 7 TIPotlb 4 Lsts ¥

S 8 TIHub , © 8 TIHub 5 Type  »

& 9 Tl Rover > 9 Tl Rover 6 110 ki

& A More Modules » & A More Wodules »

wr B Varlables  » wr B Variables  »

Items selected from the module menus will automatically add a code template to the
Editor with inline prompts for each part of the function. You can navigate from one
argument to the next by pressing (forward) or [esni)+(ta] (backward). Tooltips or
pop-up lists will appear when available to help you select the proper values.

Inline prompts Tooltips
Mg *Doc rap [l X < EEN > *Doc man [ X
[ *samples.py 314 B *Samples.py 313
from t_draw import * ffromm H_draw import *
def | (@raument: set_color(I, green,blue)

block -255

Pop-up lists

KN *Doc rap 1] X
) *Samples.py 3R
from ti_draw import *

set_pen(| ",'style")

medium
thick

The numbers to the right of the program name reflect the current line number of the
cursor and the total number of lines in the program.
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ffrom math import *

x=2
y=4.5
z=pi

def f2(n):
return n*'3

Global functions and variables defined in the lines above the current cursor position
can be inserted by pressing and selecting from the list.

B Samples.py 1111
ffrom math mport *
x=2
y=45 B
=pi i |
fo 2
def f1(n): v x
return n**2 vy
vr z
def f2(n):
return n*3]

As you add code to your program, the Editor displays keywords, operators, comments,
strings and indents in different colors to aid in identifying the different elements.

[ *Pythagoras.py 99
4ef T(a,b,0):
retUMn(@*2+h*2-cH3)

0 or fla,c.b)==0 or fib,c,a)==0:

else:
print("Non-right triangle")

Pasted menu items are placed on current line or next line based on context.

Prior to v6.2.0 v6.2.0 and later
@ *plpy 22| B *p2.py /4]
import ti_rover as rv import ti_rover as rv
rv.forwardGrv.left@0rv.forward(3))) v.forward(3)
v.left90)
rv.forward(3)
grid units

The main menu displays the module menu based on the program being edited
providing quicker access to those options. Only one module is displayed at a time.

2 Run

3 Edit

4 Built-ins
S Math
6
7
8

5
»
»
3

Random L4
Tl PlotLib »
8 TIHub »
9 TRRover >
& A More Modules 3
& B Vemier Go Direct™ »
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The Edit menu displays commonly used menu items and shortcuts.

Prior to v6.2.0 v6.2.0 and later

%1 - - + 1 Actk
b2 ;i:om Indent (TAE) b2 R
oo i, 2, Dedent (Shift <TAE) =S¥ 1_indent TAE)
2 Dedent (Shit +TAB)

e 4 Buit=3 - mentUncomment (Cirt+T)

V5 Math 4 Insert Mutj-tie Sting
5 Find... (Ctl+F)
7 L7 TIPleg popiace  cuistn

@8 TH . @8 TIH
* 9 TR 8 Beginning of Line (Ctrl+8) &9 TIR

9 End of Line (Ctrl+2)

& A Mo & A Mor
T 7)

w B varl A Jump to Top (Clrl+ ‘Y: B Ve

¥ 5 Math
@ 6 Rand @ 6 Rand

7 GotolLine... (Cr+G)
8 Insert Line Above

16 Jump to Bottom (Ctri+1)

A Go to Next Line (Ctri+Enter)

Saving and running programs

When your are finished with your program, press and select Run > Check Syntax &
Save. This will check the syntax of the Python program and save it to the TNS file.

Note: If you have unsaved changes in your program, an asterisk will display next to the
program name.

1.1

B *Pyihagoras.py am

To run the program, press and select Run > Run. This will run the current program
in the next Python Shell page or a new one if the next page is not a Shell.

Note: Running the program automatically checks the syntax and saves the program.
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Python Shell

The Python Shell is the interpreter that executes your Python programs, other pieces of
Python code, or simple commands.

Python code Simple commands

3 Python Shell 10/10 D Python Shell 1112)
>>>foriin range(S): >>3243

L. +eprini(*)

Adding a Python Shell page

To add a new Python Shell page in the current problem, press and select Add
Python > Shell.

1 Add Calculator
@ 2 Add Graphs
3 Add Geometry
[ 4 Add Lists & Spreadsheet
M 5 AddData & Statistics
6 Add Notes
7 Add Vernier DataQuest™
& 8 AddWidget
[ 9 Add Program Editor
(3 A Add Python

The Python Shell can also be launched from the Python Editor by executing a program
by pressing and selecting Run > Run.

*Pythagoras

[ Python Shell 3

>>>#Running Pythagoras.py
>>>from Pythagoras import *
55>

Working in the Python Shell

Pressing displays the Document Tools menu. With these menu options you can
add, move, and copy blocks of code.

Document Tools menu

3 ¥ 1 Tools )

E9 2 Edit » B 2 Edit » "
. 3 Bult-ins ’ e 1 def function0: NEILET
4 Math b [V .2 return ) Control  »

@ 5 Random » @ 5 Random 3 Ops 4

L6 TIPlotib > £6 TPl 4 Usts >

@ 7 TIHub ’ €7 Tl Hub 5 Type ¥

# & Tl Rover , # 8 Tl Rover @ 1© !

& 9 More Modules » & 9 More Modules

var A Variables » var A Variables »
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Note: If you use any method from one of the available modules, be sure to execute an
import module statement first as in any Python coding environment.

Interaction with the Shell output is similar to the Calculator app where you can select
and copy previous inputs and outputs for use elsewhere in the Shell, Editor, or other

apps.

Up arrow to select, then copy and paste to the desired location

[ Python Shell 30|

>>>from math import *
>>>sin(pi/2)
1

Global functions and variables from the last run program can be inserted by pressing
or [an]+[L] and selecting from the list or press and select Variables > Vars: Last
Run Program.

To choose from a list of global functions and variables from both the last run program
and any imported modules, press and select Variables > Vars: All.

Variables menu

1 Tools
2 Edit
2 Buili-ins
4 Math

5 Random
6 Tl PlotLib
7 Tl Hub

# 8 TlRover
& 9 More Modules »

Last Run Program variables  All variables

[ Python Shell feo acosh

thon Shel
Python Shell 33

>>>#Running Samples.py >>>#Running Samples, /& asin
>>>from Samples import * >>>from Samples impo fe1 asinh
>3 pe2] fis atan
o [ fia atan2
foo 2 fia atanh
f X fea ceil
L2y ft1 copysign

12z fin cos
fia cosh
i dearese ¥

All Python Shell pages in the same problem share the same state (user-defined and
imported variable definitions). When you save or run a Python program in that
problem, or press and select Tools > Reinitialize Shell, the Shell history will then
have a gray background indicating that the previous state is no longer valid.
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Before saving or reinitializing

After saving or reinitializing

() Python Shell 5/5

thon Shel
Python Shell 98

>>>#Running Samples.py
>>>from Samples import *

>>>#Running Samples.py
>>>from Samples import *

Traceback (most recent call last):

File "<stdin>", line 1, in <module>
NameError: name 'y’ isn't defined
ESS

Note: The Tools > Clear History option clears the screen of any previous activity in

the Shell, but variables are still available.

Messages

Error and other informational messages may display while you are in a Python session.

If an error is displayed in the Shell when a program executes, a program line number

will display. Press and select Go to Python Editor. In the Editor, press then
select Edit > Go to Line. Enter the line number and press [enter]. The cursor will display on

the first character of the line where the error occurred.

Interrupting a Running Program

While a program or function is running, the busy pointer ® is displayed.

» To stop the program or function,

- Windows®: Press the F12 key.
- Mac®: Press the F5 key.

- Handheld: Press the key.

Python Workspaces
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Python Menu Map

This section lists all of the menus and menu items for the Python Editor and Shell and a
brief description for each one.

Note: For the menu items that have keyboard shortcuts, Mac® users should substitute
6 (Cmd) anywhere Ctrl is used. For a complete list of TI-Nspire™ handheld and
software shortcuts, see the TI-Nspire™ Technology eGuide.

ACtIONS IMIBNU L. 11
RUN VIBNU 12
Tools MeNU .. 12
Edit Menu ..o 13
BUilt-ins MeNU ... o 15
Math MEeNU ... . 17
Random Menu ... . 18
TIPIOtLID MenU ... 19
TIHUD MenuU o 20
TIROVEr MEBNU .o 28
Complex Math Menu ... . 35
TIME MBNU L 35
TISYstem MeNU .o 36
TIDraw MENU ..o 37
THImage MenU ... 39
Variables Menu ... .. . 40

Actions Menu

Note: This applies to the Editor only.

Item Description

New Opens the New dialog box where you enter a name and select a type
for your new program.

Open Opens a list of programs available in the current document.

Create Copy Opens the Create Copy dialog box where you can save the current

program under another name.

Rename Opens the Rename dialog box where you can rename the current
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Item Description

program.
Close Closes the current program.
Settings Opens the Settings dialog box where you can change the font size for

both the Editor and Shell.

Install as Python | Checks the Python syntax of the current TNS file and moves it to the

module

PyLib folder.

Run Menu

Note: This applies to the Editor only.

Item Shortcut Description

Run Ctrl+R Checks syntax, saves program, and executes in
a Python Shell.

Check Syntax & Save Ctrl+B Checks syntax and saves program.

Go to Shell N/A Shifts focus to the Shell related to the current
program or opens a new Shell page next to the
Editor.

Tools Menu

Note: This applies to the Shell only.

Item

Shortcut

Description

Rerun Last Program

Ctrl+R

Reruns the last program related to the
current Shell.

Go to Python Editor

N/A

Opens the Editor page related to the
current Shell.

Run

N/A

Opens a list of programs available in the
current document.

After selection, the chosen program is
run.

Clear History

N/A

Clears the history in the current Shell but
does not reinitialize the Shell.

Reinitialize Shell

N/A

Resets the state of all open Shell pages in
the current problem.

All defined variables and imported
functions are no longer available.

dir()

N/A

Displays list of functions in the specified
module when used after the import
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Item

Shortcut

Description

statement.

From PROGRAM import *

N/A

Opens a list of programs available in the
current document.

After selection, the import statement is
pasted in the Shell.

Install as Python Module

N/A

Enabled only for modules in binary
format. Moves the current TNS file to the
PyLib folder.

Edit Menu

Note: Ctrl+A selects all lines of code or output for cutting or deleting (Editor only), or
copying and pasting (Editor and Shell).

Item

Shortcut

Description

Indent

TAB*

Indents text on the current line or
selected lines.

* |If there are incomplete inline

prompts, TAB will navigate to the next
prompt.

Dedent

Shift+TAB**

Dedents text on the current line or
selected lines.

** |f there are incomplete inline
prompts, Shift+TAB will navigate to the
previous prompt.

Comment/Uncomment

Ctrl+T

Adds/removes comment symbol
to/from the beginning of the current
line.

Insert Multi-line String

N/A

(Editor only) Inserts multi-line string
template.

Find

Ctrl+F

(Editor only) Opens Find dialog box and
searches for the entered string in the
current program.

Replace

Ctrl+H

(Editor only) Opens Replace dialog box
and searches for the entered string in
the current program.

Go to Line

Ctrl+G

(Editor only) Opens Go to Line dialog
box and jumps to the specified line in
the current program.

Beginning of Line

Ctrl+8

Moves cursor to the beginning of the
current line.
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Item Shortcut Description

End of Line Ctrl+2 Moves cursor to the end of the current
line.

Jump to Top Ctrl+7 Moves cursor to the beginning of the
first line in the program.

Jump to Bottom Ctrl+1 Moves cursor to the end of the last line
in the program.

Clear a Line Ctrl+del Clears the line where the cursor is

located.

Python Menu Map
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Built-ins Menu

Functions
Item Description
def function(): Defines a function dependent on specified variables.
return Defines the value produced by a function.
Control
Item Description
if.. Conditional statement.
if..else.. Conditional statement.
if..elif..else.. Conditional statement.
for index in range(size): Iterates over a range.
for index in range(start,stop): Iterates over a range.
for index in range(start,stop,step): Iterates over a range.
for index in list: Iterates over list elements.
while.. Executes statements in a code block until a
condition evaluates to False.
elif: Conditional statement.
else: Conditional statement.
Ops
Item Description
X=y Sets variable value.
X==y Pastes equal to (==) comparison operator.
xl=y Pastes not equal to (!=) comparison operator.
x>y Pastes greater than (>) comparison operator.
x>=y Pastes greater than or equal to (>=) comparison operator.
X<y Pastes less than (<) comparison operator.
X<=y Pastes less than or equal to (<=) comparison operator.

15 Python Menu Map



Item Description

and Pastes and (and) logical operator.
or Pastes or (or) logical operator.
not Pastes not (not) logical operator.
True Pastes True Boolean value.

False Pastes False Boolean value.

Lists
Item Description
1 Pastes brackets ([]).
list() Converts sequence into "list" type.
len() Returns number of elements of the list.
max() Returns maximum value in the list.
min() Returns minimum value in the list.
.append() The method appends an element to a list.
.remove() The method removes the first instance of an

element from a list.

range(start,stop,step)

Returns a set of numbers.

for index in range(start,stop,step)

Used to iterate over a range.

.insert() The method adds an element at the specified
position.

.split() The method returns a list with elements
separated by specified delimiter.

sum() Returns sum of the elements of a list.

sorted() Returns a sorted list.

.sort() The method sorts a list in place.

Type

Item Description

int() Returns an integer part.

float() Returns a float value.

Python Menu Map
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Item

Description

round(x,ndigits)

Returns a floating point number rounded to the specified number
of digits.

str() Returns a string.

complex() Returns a complex number.

type() Returns the type of the object.
1/0

Item Description

print() Displays argument as string.

input() Prompts user for input.

eval() Evaluates an expression represented as a string.

format() The method formats the specified string.
Math Menu

Note: When creating a new program that uses this module, it is recommended to use
the Math Calculations program type. This will ensure that all the relevant modules are

imported.

Item

Description

from math import *

Imports all methods (functions) from the math module.

fabs()

Returns absolute value of a real number.

sqrt() Returns square root of a real number.

exp() Returns e**x.

pow(x,y) Returns x raised to the powery.

log(x,base) Returns logpasa(X).
log(x) with no base returns the natural logarithm x.

fmod(x,y) Returns module value of x and y. Use when x and y are floats.

ceil() Returns the smallest integer greater than or equal to a real
number.

floor() Returns the largest integer less than or equal to a real
number.

trunc() Truncates a real number to an integer.

frexp() Returns a pair (y,n) where x ==y * 2**n,
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Const

Item Description
e Returns value for the constant e.
pi Returns value for the constant pi.

Trig
Item Description
radians() Converts angle in degrees to radians.
degrees() Converts angle in radians to degrees.
sin() Returns sine of argument in radians.
cos() Returns cosine of argument in radians.
tan() Returns tangent of argument in radians.
asin() Returns arc sine of argument in radians.
acos() Returns arc cosine of argument in radians.
atan() Returns arc tangent of argument in radians.
atan2(y,x) Returns arc tangent of y/x in radians.

Random Menu

Note: When creating a new program that uses this module, it is recommended to use
the Random Simulations program type. This will ensure that all the relevant modules

are imported.

Item

Description

from random import *

Imports all methods from the random module.

random()

Returns a floating point number from 0 to 1.0.

uniform(min,max)

Returns a random number x (float) such that min <= x
<= max.

randint(min,max)

Returns a random integer between min and max.

choice(sequence)

Returns a random element from a non-empty
sequence.

randrange(start,stop,step)

Returns a random number from start to stop by step.

Python Menu Map 18



Item Description

seed() Initializes random number generator.

Tl PlotLib Menu

Note: When creating a new program that uses this module, it is recommended to use
the Plotting (x,y) & Text program type. This will ensure that all the relevant modules are
imported.

Item Description

import ti_plotlib as plt Imports all methods (functions) from the ti_plotlib module
in the "plt" namespace. As a result, all function names
pasted from the menus will be preceded by "plt.".

Setup

Item Description

cls() Clears the plotting canvas.

grid(x-scale,y-scale,"style") Displays a grid using specified scale for xand y
axes.

window(xmin,xmax,ymin,ymax) Defines the plotting window by mapping the the
specified horizontal interval (xmin, xmax) and
vertical interval (ymin, ymax) to the allotted
plotting area (pixels).

auto_window(x-list,y-list) Autoscales the plotting window to fit the data
ranges within x-list and y-list specified in the
program prior to the auto_window().

axes("mode") Displays axes on specified window in the plotting
area.

labels("x-label","y-label",x,y) Displays "x-label" and "y-label" labels on the plot
axes at row positions x and y.

title("title") Displays "title" centered on top line of window.

show_plot() Displays the buffered drawing output.
The use_buffer() and show_plot() functions are
useful in cases where displaying multiple objects
on the screen could cause delays (not necessary in
most cases).

use_buffer() Enables an off-screen buffer to speed up drawing.
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Draw

Item

Description

color(red,green,blue)

Sets the color for all following graphics/plotting.

cls()

Clears the plotting canvas.

show_plot()

Executes the display of the plot as set up in the
program.

scatter(x-list,y-list,"mark")

Plots a sequence of ordered pair from (x-list,y-list)
with the specified mark style.

plot(x-list,y-list,"mark")

Plots a line using ordered pairs from specified x-list
and y-list.

plot(x,y,"mark")

Plots a point using coordinates x and y with the
specified mark style.

line(x1,y1,x2,y2,"mode")

Plots a line segment from (x1,y1) to (x2,y2).

lin_reg(x-list,y-list,"display")

Calculates and draws the linear regression model,
ax+b, of x-list,y-list.

pen("size","style")

Sets the appearance of all following lines until the
next pen() is executed.

non

text_at(row,"text","align")

Displays "text" in plotting area at specified "align".

Properties
Item Description
xmin Specified variable for window arguments defined as plt.xmin.
Xmax Specified variable for window arguments defined as plt.xmax.
ymin Specified variable for window arguments defined as plt.ymin.
ymax Specified variable for window arguments defined as plt.ymax.
m After plt.linreg() is executed in a program, the computed values of slope, m,
and intercept, b, are stored in plt.m and plt.b.
b After plt.linreg() is executed in a program, the computed values of slope, a,
and intercept, b, are stored in plt.a and plt.b.
Tl Hub Menu

Note: When creating a new program that uses this module, it is recommended to use
the Hub Project program type. This will ensure that all the relevant modules are

imported.
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Item

Description

from ti_hub import *

Imports all methods from the ti_hub module.

Hub Built-in Devices > Color Output

Item Description

rgb(red,green,blue) Sets the color for the RGB LED.

blink(frequency,time) Sets the blinking frequency and duration for the selected
color.

off() Turns the RGB LED off.

Hub Built-in Devices > Light Output

Item Description
on() Turns the LED on.
off() Turns the LED off.

blink(frequency,time)

Sets the blinking frequency and duration for the LED.

Hub Built-in Devices > Sound Output

Item

Description

tone(frequency,time)

Plays a tone of the specified frequency for the
specified time.

note("note",time)

Plays the specified note for the specified time.

The note is specified using the note name and an
octave. For example: A4, C5.

The note names are C, CS, D, DS, E, F, FS, G, GS, A, AS,
and B.

The octave numbers range from 1 to 9 (inclusive).

tone(frequency,time,tempo)

Plays a tone of the specified frequency for the
specified time and tempo.

The tempo defines the number of beeps per second
ranging from 0 to 10 (inclusive).

note("note",time,tempo)

Plays the specified note for the specified time and
tempo.
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Item

Description

The note is specified using the note name and an
octave. For example: A4, C5.

The note names are C, CS, D, DS, E, F, FS, G, GS, A, AS,
and B.

The octave numbers range from 1 to 9 (inclusive).
The tempo numbers range from 0 to 10 (inclusive).

Hub Built-in Devices > Brightness Input

Item Description

measurement() Reads the built-in BRIGHTNESS (light level) sensor and returns a

reading.

The default range is 0 to 100. This can be changed using the range
() function.

range(min,max) Sets the range for mapping the readings from the light level

sensor.

If both are missing, or set to a value of None, then the default
brightness range of 0 to 100 is set.

Add Input Device

This menu has a list of the sensors (input devices) supported by the ti_hub module. All
the menu items will paste the name of the object and expect a variable and a port used
with the sensor. Each sensor has a measurement() method that returns the value of the

sensor.

Item

Description

DHT (Digital Humidity & Temp)

Returns a list consisting of the current
temperature, humidity, type of sensor, and last
cached read status.

Ranger

Returns the current distance measurement from
the specified ultrasonic ranger.
e measurement_time() - Returns the time that

the ultrasonic signal takes to reach the object
(the "time of flight").

Light Level

Returns the brightness level from the external light
level (brightness) sensor.

Temperature

Returns the temperature reading from the external
temperature sensor.
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Item

Description

The default configuration is to support the Seeed
temperature sensorin IN 1, IN 2 or IN 3 ports.

To use the TI LM19 Temperature sensor from the
Tl-Innovator™ Hub breadboard pack, edit the port
to the BB pin in use and use an optional argument
"TIANALOG".

Example: mylm19=temperature("BB

5" "TIANALOG")

Moisture

Returns the moisture sensor reading.

Magnetic

Detects the presence of a magnetic field.

The threshold value to determine the presence of
the field is set through the trigger() function.

The default value of the threshold is 150.

Vernier

Reads the value from the Vernier analog sensor
specified in the command.

The command supports the following Vernier
sensors:

e temperature - Stainless Steel Temperature
sensor.

o lightlevel - Tl Light level sensor.

e pressure - Original gas pressure sensor

e pressure - Newer gas pressure sensor.

e pH-pH sensor.

e forcel0 - £10 N setting, Dual Force Sensor.
e force50 - 50 N setting, Dual Force Sensor.
e accelerometer - Low-G Accelerometer.

e generic - Allows setting of other sensors not
supported directly above, and use of the
calibrate() APl above to set equation
coefficients.

Analog In

Supports the use of analog input generic devices.

Digital In

Returns the current state of the digital pin
connected to the DIGITAL object, or the cached
state of the digital output value last SET to the
object.

Potentiometer

Supports a potentiometer sensor.

The range of the sensor can be changed by the
range() function.

Thermistor

Reads thermistor sensors.
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Item

Description

The default coefficients are designed to match the
thermistor included in the Breadboard Pack of the
Tl-Innovator™ Hub, when used with a 10KQ fixed
resistor.

A new set of calibration coefficients and reference
resistance for the thermistor can be configured
using the calibrate() function.

Loudness

Supports sound loudness sensors.

Color Input

Provides interfaces to an 12C-connected Color Input
sensor.

The bb_port pin is used in addition to the 12C port
to control the LED on the color sensor.

e color_number(): Returns a value from 1 to 9
that represents the color the sensor is
detecting.

The numbers represent the colors per the
following mapping:

: Red

: Green

: Blue

: Cyan

: Magenta
: Yellow

: Black

: White

: Gray

red(): Returns a value from 0 to 255 that
represents the intensity of the RED color level
being detected.

e green(): Returns a value from 0 to 255 that
represents the intensity of the GREEN color
level being detected.

e blue(): Returns a value from 0 to 255 that
represents the intensity of the BLUE color level
being detected.

e gray(): Returns a value from 0 to 255 that
represents the gray level being detected,
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Item

Description

where 0 is black and 255 is white.

BB Port

Provides support for using all 10 BB port pins as a
combined digital input/output port.

The initialization functions have an optional "mask"
parameter that allows the use of the subset of the
10 pins.

e read_port(): Reads the current values on the
input pins of the BB port.

e write_port(value): Sets the output pin values to
the specified value, where value is between 0
and 1023. Note that the value is also adjusted
against the mask value in the var=bbport
(mask) operation, if a mask was provided.

Hub Time

Provides access to the internal millisecond timer.

TI-RGB Array

Provides functions for programming the TI-RGB
Array.

The initialization function accepts an optional

"LAMP" parameter to enable a high-brightness

mode for the TI-RGB Array that requires an

external power supply.

e set(led_position, r,g,b): Sets a specific led_
position (0-15) to the specified r,g,b value,
where r,g,b are values from 0 to 255.

o set(led_list,red,green,blue): Sets the LEDs
defined in the "led_list" to the color specified
by "red", "green", "blue". The "led_list" is a
Python list that includes indexes of the LEDs
from 0 to 15. For example, the set([0,2,4,6,15],
0, 0, 255) will set LEDs 0O, 2, 4, 6 and 15 to blue.

e set_all(r,g,b): Sets all RGB LEDs in the array to
the same r,g,b value.

e all_off(): Turns off all RGBs in the array.

e measurement(): Returns the approximate
current draw that the RGB array is using from
the Tl-Innovator™ in milliAmps.

e pattern(pattern): Using the value of the
argument as a binary value in the range 0 to
65535, turns on pixels where a 1 value in the
representation would be. LEDs are turned on
as RED with pwm level value of 255.

e pattern(value,red,green,blue): Sets the LEDs

defined by the "pattern" to the color specified
by "red", "green", "blue".
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Add Output Device

This menu has a list of the output devices supported by the ti_hub module. All the
menu items will paste the name of the object and expect a variable and a port used

with the device.

Item Description

LED Functions for controlling externally connected LEDs.

RGB Support for controlling external RGB LEDs.

TI-RGB Array Provides functions for programming the TI-RGB Array.

Speaker Functions for supporting an external speaker with the TI-
Innovator™ Hub.
The functions are the same as the ones for "sound" above.

Power Functions for controlling external power with the Tl-Innovator™

Hub.

e set(value): Sets the Power level to the specified value,
between 0 and 100.

e on(): Sets the Power level to 100.
o off(): Sets the Power level to 0.

Continuous Servo

Functions for controlling continuous servo motors.

e set_cw(speed,time): The servo will spin in the clockwise
direction at the specified speed (0-255) and for the specific
duration in seconds.

e set_ccw(speed,time): The servo will spin in the counter-
clockwise direction at the specified speed (0-255) and for
the specific duration in seconds.

e stop(): Stops the continuous servo.

Analog Out

Functions for the use of analog input generic devices.

Vibration Motor

Functions for controlling vibration motors.

e set(val): Sets the vibration motor intensity to "val" (0-255).
e off(): Turns the vibration motor off.

e on(): Turns the vibration motor on at the highest level.

Relay Controls interfaces for controlling relays.

e on(): Sets the relay to the ON state.

o off(): Sets the relay to the OFF state.
Servo Functions for controlling servo motors.

e set_position(pos): Sets the sweep servo position within a

range of -90 to +90.

e zero(): Sets the sweep servo to the zero position.

Squarewave Functions for generating a square wave.
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Item Description

e set(frequency,duty,time): Sets the output squarewave with a
default duty cycle of 50% (if duty is not specified) and an
output frequency specified by "frequence". The frequency
may be from 1 to 500 Hz. The duty cycle, if specified, may be
from 0 to 100%.

e  off(): Turns the squarewave off.

Digital Out Interfaces for controlling a digital output.
e set(val): Sets the digital output to the value specified by
"val" (0 or 1).

e on(): Sets the state of the digital output to high (1).
o off(): Sets the state of the digital output to low (0).

BB Port Provides functions for programming the TI-RGB Array.
See the details above.

Commands

Item Description

sleep(seconds) Pauses the program for the specified number of
seconds.
Imported from the 'time' module.

text_at(row,"text","align") Displays the specified "text" in the plotting area at
specified "align".
Part of the ti_plotlib module.

cls() Clears the Shell screen for plotting.
Part of the ti_plotlib module.

while get_key() !="esc": Runs the commands in the "while" loop until the "esc"
key is pressed.

get_key() Returns a string representing the key pressed.
The '1' key returns "1", 'esc' returns "esc", and so on.
When called without any parameters - get_key() - it
returns immediately.
When called with a parameter - get_key(1) - it waits
until a key is pressed.
Part of the ti_system module.

Ports

These are the input and output ports available on the Tl-Innovator™ Hub.
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Item
ouTt
ouT2
out3

IN1

IN 2

IN3

BB 1
BB2

BB 3

BB 4

BB 5

BB 6

BB 7
BB8

BB 9
BB10

12C
TI Rover Menu
Note: When creating a new program that uses this module, it is recommended to use

the Rover Coding program type. This will ensure that all the relevant modules are
imported.

Item Description

import ti_rover as rv Imports all methods (functions) from the ti_rover module in
the "rv" namespace. As a result, all function names pasted
from the menus will be preceded by "rv.".

Drive
Item Description
forward(distance) Moves Rover forward the specified distance in grid
units.
backward(distance) Moves Rover backward the specified distance in grid
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Item

Description

units.

left(angle_degrees)

Turns Rover left the specified angle in degrees.

right(angle_degrees)

Turns Rover right the specified angle in degrees.

stop()

Stops any current movement immediately.

stop_clear()

Stops any current movement immediately and clears all
pending commands.

resume() Resumes the processing of commands.
stay(time) Rover stays in place for the specified amount of time in
seconds (optional).
If no time is specified, the Rover stays for 30 seconds.
to_xy(x,y) Moves Rover to coordinate position (x,y) on virtual grid.

to_polar(r,theta_degrees)

Moves Rover to polar coordinate position (r, theta) on
virtual grid.

The angle is specified in degrees.

to_angle(angle,"unit")

Spins Rover to the specified angle in the virtual grid.

The angle is relative to a zero angle which points down
the x-axis in the virtual grid.

Drive > Drive with Options

Item

Description

forward_time(time)

Moves Rover forward for the specified
time.

backward_time(time)

Moves Rover backward for the specified
time.

forward(distance,"unit")

Moves Rover forward at the default speed
for the specified distance.

The distance can be specified in grid units,
meters, or wheel revolutions.

backward(distance,"unit")

Moves Rover backward at the default
speed for the specified distance.

The distance can be specified in grid units,
meters, or wheel revolutions.

left(angle,"unit")

Turns Rover left the specified angle.

The angle can be in degrees, radians, or
gradians.
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Item

Description

right(angle,"unit")

Turns Rover right the specified angle.

The angle can be in degrees, radians, or
gradians.

forward_time(time,speed,"rate")

Moves Rover forward for the specified
time at the specified speed.

The speed can be specified in grid units/s,
meters/s, or wheel revolutions/s.

backward_time(time,speed,"rate")

Moves Rover backward for the specified
time at the specified speed.

The speed can be specified in grid units/s,
meters/s, or wheel revolutions/s.

forward(distance,"unit",speed,"rate")

Moves Rover forward for the specified
distance at the specified speed.

The distance can be specified in grid units,
meters, or wheel revolutions.

The speed can be specified in grid units/s,
meters/s, or wheel revolutions/s.

backward(distance,"unit",speed,"rate") Moves Rover backward for the specified

distance at the specified speed.
The distance can be specified in grid units,
meters, or wheel revolutions.

The speed can be specified in grid units/s,
meters/s, or wheel revolutions/s.

Inputs

Item

Description

ranger_measurement()

Reads the ultrasonic distance sensor on the front
of the Rover, returning the current distance in
meters.

color_measurement()

Returns a value from 1 to 9, indicating the
predominant color being "seen" by the Rover color
input sensor.

1=red

2 =green

3 =blue

4 =cyan

5 = magenta
6 = yellow
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Item

Description

7 = black
8 =grey
9 = white

red_measurement()

Returns a value between 0 and 255 that indicates
the perceived red level being seen by the color
input sensor.

green_measurement()

Returns a value between 0 and 255 that indicates
the perceived green level being seen by the color
input sensor.

blue_measurement()

Returns a value between 0 and 255 that indicates
the perceived blue level being seen by the color
input sensor.

gray_measurement()

Returns a value between 0 and 255 that indicates
the perceived gray level being seen by the color
input sensor.

encoders_gyro_measurement()

Returns a list of values that contains the left and
right wheel encoder counts as well as the current
gyro heading.

gyro_measurement()

Returns a value that represents the current gyro
reading, including drift, in the degrees.

ranger_time()

Returns the time that the ultrasonic signal from
the TI-Rover ranger takes to reach the object (the
"time of flight").

Outputs

Item

Description

color_rgb(r,g,b)

Sets the color of the Rover RGB LED to
the specific red, green, blue values.

color_blink(frequency,time)

Sets the blinking frequency and
duration for the selected color.

color_off()

Turns the Rover RGB LED off.

motor_left(speed,time)

Sets the left motor power to the
specified value for the specified
duration.

The speed is in the range -255 to 255
with 0 being stop. Positive speed values
are counter-clockwise rotation, and
negative speed values are clockwise.
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Item Description

The optional time parameter, if
specified, has a valid range of 0.05 to
655.35 seconds. If not specified, a
default of 5 seconds is used.

motor_right(speed,time) Sets the left motor power to the
specified value for the specified
duration.

The speed is in the range -255 to 255
with 0 being stop. Positive speed values
are counter-clockwise rotation, and
negative speed values are clockwise.

The optional time parameter, if
specified, has a valid range of 0.05 to
655.35 seconds. If not specified, a
default of 5 seconds is used.

motors("ldir",left_val,"rdir",right_val,time) Sets the left and right wheel to the
specified speed levels, for an optional
amount of time in seconds.

The speed (left_val, right_val) values
are in the range 0 to 255 with 0 being
stop. The Idir and rdir parameters
specify CW or CCW rotation of the
respective wheels.

The optional time parameter, if
specified, has a valid range of 0.05 to
655.35 seconds. If not specified, a
default of 5 seconds is used.

Path

Item Description

waypoint_xythdrn() Reads the x-coord, y-coord, time, heading, distance traveled,
number of wheel revolutions, command number of the
current waypoint. Returns a list with all these values as
elements.

waypoint_prev Reads the x-coord, y-coord, time, heading, distance traveled,
number of wheel revolutions, command number of the
previous waypoint.

waypoint_eta Returns the estimated time to drive to a waypoint.

path_done() Returns a value of 0 or 1 depending on whether the Rover is
moving (0) or finished with all movement (1).
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Item Description

pathlist_x() Returns a list of X values from the beginning to and including
the current Waypoint X value.

pathlist_y() Returns a list of Y values from the beginning to and including

the current Waypoint Y value.

pathlist_time()

Returns a list of the time in seconds from the beginning to
and including the current Waypoint time value.

pathlist_heading()

Returns a list of the headings from the beginning to and
including the current Waypoint heading value.

pathlist_distance()

Returns a list of the distances traveled from the beginning to
and including the current Waypoint distance value.

pathlist_revs()

Returns a list of the number of revolutions traveled from the
beginning to and including the current Waypoint revolutions
value.

pathlist_cmdnum()

Returns a list of command numbers for the path.

waypoint_x()

Returns x coordinate of current waypoint.

waypoint_y()

Returns y coordinate of current waypoint.

waypoint_time()

Returns time spent traveling from previous to current
waypoint.

waypoint_heading()

Returns absolute heading of current waypoint.

waypoint_distance()

Returns distance traveled between previous and current
waypoint.

waypoint_revs()

Returns number of revolutions needed to travel between
previous and current waypoint.

Settings
Item Description
units/s Option for speed in grid units per second.
m/s Option for speed in meters per second.
revs/s Option for speed in wheel revolutions per second.
units Option for distance in grid units.
m Option for distance in meters.
revs Option for distance in wheel revolutions.
degrees Option for turning in degrees.
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Item Description

radians Option for turning in radians.
gradians Option for turning in gradians.
clockwise Option for specifying wheel direction.

counter-clockwise

Option for specifying wheel direction.

Commands

These commands are collection of functions from other modules as well as from the TI

Rover module.

Item

Description

sleep(seconds)

Pauses the program for the specified number of
seconds.

Imported from the time module.

"o

text_at(row,"text","align")

Displays "text" in plotting area at specified "align".
Imported from the ti_plotlib module.

cls()

Clears the Shell screen for plotting.
Imported from the ti_plotlib module.

while get_key() !="esc":

Runs the commands in the "while" loop until the "esc"
key is pressed.

wait_until_done()

Pauses the program until the Rover finishes the
current command.

This is a helpful way to synchronize non-Rover
commands with Rover's motion.

while not path_done()

Runs the commands in the "while" loop until the
Rover is finished with all movement.

The path_done() function returns a value of 0 or 1
depending on whether the Rover is moving (0) or
finished with all movement (1).

position(x,y)

Sets the Rover position on the virtual grid to the
specified x,y coordinate.

position(x,y,heading,"unit")

Sets the Rover position on the virtual grid to the
specified x,y coordinate, and the virtual heading,
relative to the virtual x-axis is set if a heading is
provided (in the units for angles specified).

Positive angles from 0 to 360 are assumed to be
counter-clockwise from the positive x axis. Negative
angles from 0 to -360 are assumed to be clockwise
from the positive x axis.
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Item

Description

grid_origin()

Sets RV as being at current grid origin point of (0,0).

grid_m_unit(scale_value)

Sets the virtual grid spacing in meters per unit (m/unit)
to the value specified. 0.1 is the default m/unit and
translates to 1 unit = 100 mm or 10 cm or 1 dmor 0.1
m.

The range of valid scale_value is from 0.01 to 10.0.

path_clear()

Clears any pre-existing path or waypoint information.

zero_gyro()

Resets the Rover gyro to 0.0 angle and clears the left
and right wheel encoder counts.

Complex Math Menu

This submenu is located under More Modules.

Item

Description

from cmath import *

Imports all methods from the cmath module.

complex(real,imag)

Returns a complex number.

rect(modulus,argument)

Converts polar coordinates to rectangular form of a
complex number.

.real Returns real part of the complex number.

.imag Returns imaginary part of a complex number.

polar() Converts rectangular form to polar coordinates of a

complex number.

phase() Returns phase of a complex number.

exp() Returns e**x.

cos() Returns cosine of a complex number.

sin() Returns sine of a complex number.

log() Returns natural logarithm of a complex number.

log10() Returns base 10 logarithm of a complex number.

sqrt() Returns square root of a complex number.
Time Menu

This submenu is located under More Modules.

Item

Description

from time import *

Imports all methods from the time module.
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Item

Description

sleep(seconds)

Pauses the program for the specified number of seconds.

clock()

Returns the current processor time as a floating number
expressed in seconds.

localtime()

Converts a time expressed in seconds since January 1, 2000
into a nine-tuple containing year, month, month day, hour,
minute, second, weekday, year day, and Daylight Savings Time
(DST) flag.

If the optional (seconds) argument is not provided, then the
real-time clock is used.

ticks_cpu()

Returns a processor specific increasing millisecond counter
with arbitrary reference point.

For measuring time consistently across different systems, use
ticks_ms().

ticks_diff()

Measures period between consecutive calls to ticks_cpu() or
ticks_ms().

This function should not be used to measure arbitrarily long
periods of time.

Tl System Menu

This submenu is located under More Modules.

Note: When creating a new program that uses this module, it is recommended to use
the Data Sharing program type. This will ensure that all the relevant modules are

imported.

Item

Description

from ti_system import *

Imports all methods (functions) from the ti_system
module.

recall_value("name")

Recalls a predefined OS variable (value) named
"name".

store_value("name",value) Stores a Python variable (value) to an OS variable

named "name".

recall_list("name"

Recalls a predefined OS list named "name".

store_list("name",list)

Stores a Python list (list) to an OS list variable named
"name".

eval_function("name",value) Evaluates a predefined OS function at the specified

value.

get_platform()

Returns "hh" for handheld and "dt" for desktop.

get_key()

Returns a string representing the key pressed.
The '1' key returns "1", 'esc' returns "esc", and so on.
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Item Description

When called without any parameters - get_key() - it
returns immediately.
When called with a parameter - get_key(1) - it waits
until a key is pressed.

get_mouse() Returns mouse coordinates as a two element tuple,

either the canvas pixel position or (-1,-1) if outside
the canvas.

while get_key() !="esc":

Run the commands in the "while" loop until the "esc'
key is pressed.

clear_history() Clears the Shell history.
get_time_ms() Returns time in milliseconds with millisecond
precision.

This functionality can be used to calculate a duration
rather than determine the actual clock time.

TI Draw Menu
This submenu is located under More Modules.

Note: When creating a new program that uses this module, it is recommended to use
the Geometry Graphics program type. This will ensure that all the relevant modules are
imported.

Item Description

from ti_draw import * Imports all methods from the ti_draw module.
Shape

Item Description

draw_line() Draws a line starting from the specified x1,y1 coordinate to x2,y2.

draw_rect() Draws a rectangle starting at the specified x,y coordinate with the

specified width and height.

fill_rect() Draws a rectangle starting at the specified x,y coordinate with the
specified width and height and filled with the specified color (using
set_color or black if not defined).

draw_circle() Draws a circle starting at the specified x,y center coordinate with the
specified radius.

fill_circle() Draws a circle starting at the specified x,y center coordinate with the
specified radius and filled with the specified color (using set_color or
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Item

Description

black if not defined).

draw_text()

Draws a text string starting at the specified x,y coordinate.

draw_arc() Draws an arc starting at the specified x,y coordinate with the
specified width, height and angles.

fill_arc() Draws an arc starting at the specified x,y coordinate with the
specified width, height and angles filled with the specified color
(using set_color or black if not defined).

draw_poly() Draws a polygon using the specified x-list,y-list values.

fill_poly() Draws a polygon using the specified x-list,y-list values filled with the
specified color (using set_color or black if not defined).

plot_xy() Draws a shape using the specified x,y coordinate and specified
number from 1-13 representing different shapes and symbols (see
below).

plot_xy symbols
...... c000@0
123456789 10111213
Control
Item Description
clear() Clears the entire screen. Can be used with x,y,width,height

parameters to clear an existing rectangle.

clear_rect()

Clears the rectangle at the specified x,y coordinate with the
specified width and height.

set_color() Sets the color of the shape(s) that follow in the program until
another color is set.
set_pen() Sets the specified thickness and style of the border when

drawing shapes (not applicable when using fill commands).

set_window()

Sets the size of the window in which any shapes will be drawn.

This function is useful to resize the window to match the data or
to change the origin (0,0) of the drawing canvas.

get_screen_dim()

Returns the xmax and ymax of the screen dimensions.

use_buffer()

Enables an off-screen buffer to speed up drawing.

paint_buffer()

Displays the buffered drawing output.
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Item Description

delays.

The use_buffer() and paint_buffer() functions are useful in cases
where displaying multiple objects on the screen could cause

Notes

¢ The default configuration has (0,0) in the top left corner of the screen. The positive
x-axis points to the right and the positive y-axis points to the bottom This can be
modified by using the set_window() function.

e The functions in ti_draw module are only available on the handheld and in

handheld view on desktop.

Tl Image Menu

This submenu is located under More Modules.

Note: When creating a new program that uses this module, it is recommended to use
the Image Processing program type. This will ensure that all the relevant modules are

imported.

Item

Description

from ti_image import *

Imports all methods from the ti_image module.

new_image(width,height,(r,g,b))

Creates a new image with the specified width and
height for use in the Python program.

The color of the new image is defined by the
(r,g,b) values.

load_image("name")

Loads the image specified by the "name" for use
in the Python program.

The image must be part of the TNS document
either in a Notes or Graphs application.

The "name" prompt will display the image names

(if they have been named earlier) or a number
indicating their insertion order.

copy_image(image)

Creates a copy of the image specified by the
"image" variable.

Methods of the image object

Additional functions related to the image objects are available in the Editor and Shell by
typing the variable name followed by a . (dot).

39 Python Menu Map



(@ *zoy 5/5

from ti_image import *

::g get_pixel(x,y)
" set_pixel(x,y,color_tuple)
show_image(x,y)

e get_pixel(x,y): Gets the (r,g,b) value of the pixel at location defined by the (x,y)
coordinate pair.

px_val = get pixel(100,100)
print (px_val)

e set_pixel(x,y,color_tuple): Sets the pixel at location (x,y) to the color specified in the
color_tuple.
set_pixel (100,100, (0,0,255))

Sets the pixel at (100,100) to the (0,0,255) color.

e show_image(x,y): Displays the image with the top left corner at location (x,y).
¢ w, h, name: Gets the width, height, and name parameters of the image.

Example
from ti image import *

# An image has been previously inserted into the TNS document in a Notes
application and named "bridge"

iml=load image ("bridge")

px val = iml.get pixel (100,100)

print (px val) B

# Set the pixel at 100,100 to blue (0,0,255)

iml.set_pixel (100,100, (0,0,255)

new_px = iml.get pixel(100,100)

print (new_px)

# Print the width, height and name of the image
print (iml.w, iml.h, iml.name)

Variables Menu

Note: These lists do not include variables defined in any other TI-Nspire™ apps.

Item Description

Vars: Current Program (Editor only) Displays a list of global functions and variables
defined in the current program

Vars: Last Run Program (Shell only) Displays a list of global functions and variables
defined in the last run program

Vars: All (Shell only) Displays a list of global functions and variables
from both the last run program and any imported modules
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Appendix

Python Keywords

Python Key Mapping

Sample Python Programs

Python Keywords

The following keywords are built into the TI-Nspire™ Python implementation.

False elif lambda
None else nonlocal
True except not
and finally or
as for pass
assert from raise
break global return
class if try
continue import while
def in with
del is yield
Python Key Mapping

When entering code in the Editor or in the Shell, the keypad is designed to paste the
appropriate Python operations or open menus for easy entry of functions, keywords,
methods, operators, etc.

Key Mapping
Opens Variables menu
st Pastes = sign
2] Deletes character to the left of the cursor
cear, No action
=] Pastes = sign
ez Pastes the selected symbol(s):
¢« >
¢« <
) |=
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Key

Mapping

L] >=
L] <=
. ==

e and

e not
e |
e &

° ~

Pastes the selected function:

* sin

* cos

e tan

e atan2
e asin
® acos
e atan

Displays hints

Pastes :=

Pastes **

No action

Pastes **2

Pastes sqrt()

Pastes multiply sign (*)

Pastes one double quote (")

Pastes division sign (/)

No action

Pastes exp()

Pastes log()

Pastes 10**

Pastes log(value,base)

Pastes (

Pastes )
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Key Mapping
g Pastes [ ]
Ko Pastes { }
©) Pastes subtract sign (-)
= Adds a new line after the current line
) Pastes E
Pastes the selected symbol(s):
. 2
o 1
e S
. o
° ll
e %
° n
L]
e
o -
o\
e #
Pastes "pi"
(=) Existing flag behavior
Adds a new line after the current line

Sample Python Programs

Use the following sample programs to become familiar with Python methods. They are

also available in the Getting Started Python.tns file located in the Examples folder.

Note: If you copy and paste any sample code that contains tab indent indicators (
the TI-Nspire™ software, you will need to replace those instances with actual tab
indents.

Hello

# This program asks for your name and uses
# it in an output message.
# Run the program here by typing "Ctrl R"

name=input ("What's your name? ")
print ("Hello, ", name)
print ("\n Press ctrl+R to run again")

) to
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() Python Shell

7

>>>#Running Sample.py
>>>from Sample import *
What's your name? Thornas
Hello, Thomas

>>>

Press ctrl+R to run again
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Loop Example

# This program uses a "for" loop to calculate
# the squares and cubes of the first 5 numbers
#0,1,2,3,4

# Note: Python starts counting at 0

for index in range (5):
square = index**2

cube = index**3
print ("Index: ", index, "Square: ", square,
"Cube: ", cube)

3 Square: © Cube: 27
4 Square: 16 Cube: 64
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Heads or Tails

# Use random numbers to simulate a coin flip
# We will count the number of heads and tails
# Run the program here by typing "Ctrl R"

# Import all the functions of the "random" module
from random import *

# n is the number of times the die is rolled
def coin flip(n):
heads = tails = 0
for i in range(n):
# Generate a random integer - 0 or 1
# "0" means head, "1" means tails
side=randint (0, 1)
if (side == 0):
heads = heads + 1
else:
tails = tails + 1
# Print the total number of heads and tails
print (n, "coin flips: Heads: ", heads, "Tails: "

’

tails)

print ("\nPress the Var key and select 'coin flip()'")

print ("In the ( ), enter a number of flips!™)

>>>from Sample import *
o>

Press the Var key and select ‘cain_flipt)’
Inthe (), enter a number of flips!
>>>coin_flip(10)

10 coin flips: Heads: 4 Tails: 6

ESSN
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Plotting

# Plotting example
import ti_plotlib as plt

# Set up the graph window
plt.window(-10,10,-10,10)

plt.axes ("on")

plt.grid (1,1, "dashed")

# Add leading spaces to position the title
plt.title(" TITLE")

# Set the pen style and the graph color
plt.pen("medium", "solid")
plt.color(28,242,221)
plt.line(-5,5,5,-5,"arrow")

plt.pen("thin", "dashed")
plt.color(224,54,243)
plt.line(-5,-5,5,5,"")

# Scatter plot from 2 lists
plt.color(0,0,0)
x1list=[1,2,3,4,5]
ylist=[5,4,3,2,1]
plt.scatter(xlist,ylist, "x")

10 TTLE

fox
x

47 Appendix



Drawing
from ti draw import *

# (0,0) is in top left corner of screen

# Let's draw some circles and squares

# Circle with center at (50,50) and radius 40
draw circle(50,50,40)

# Set color to red (255,0,0) and fill a rectangle of
# of width 180, height 80 with top left corner at

# (100,100)

set color(255,0,0)

f£ill rect(100,100,180,80)

# Set color to green and pen style to "thin"
# and "dotted".

# Then, draw a circle with center at (200,100)
# and radius 40

set_color(0,255,0)

set pen("thin","dotted")
draw_circle(200,100,40)

set color(0,0,0)
draw text (20,200, "Press Enter to exit")

@

Press Enter to exit
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Image

# Image Processing
H

b
from ti image import *
from ti draw import *

# Load and show the 'manhole cover' image
# It's in a Notes app

# Draw a circle on top
iml=load image ("manhole cover")
iml.show_image (0, 0)

set _color(0,255,0)

set pen("thick","dashed")

draw circle(140,110,100)
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Hub

This program uses Python to control the TI-Innovator™ Hub, a programmable
microcontroller. Running the program without attaching a Tl-Innovator™ Hub will
display an error message.

For more information about TI-Innovator™ Hub, visit education.ti.com.

#========== TImport Section ==========
from ti hub import *

from math import *

from random import *

from time import sleep

from ti plotlib import text at,cls

from ti system import get key

#======== End of Import Section =======

print ("Connect the TI-Innovator Hub and hit 'enter'"
input ()

print ("Blinking the RGB LED for 4 seconds"

# Set the RGB LED on the Hub to purple
color.rgb(255,0,255)

# Blink the LED 2 times a second for 4 seconds
color.blink(2,4)

sleep (5)
print ("The brightness sensor reading is: ", brightness.measurement())

# Generate 10 random colors for the RGB LED
# Play a tone on the Hub based on the random
# color
print ("Generate 10 random colors on the Hub & play a tone")
for i in range (10):

r=randint (0, 255)

b=randint (0,255)

g=randint (0, 255)

color.rgb(r,g,b)

sound.tone ( (r+g+b) /3,1)

sleep (1)

color.off ()
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General Information
Online Help

education.ti.com/eguide

Select your country for more product information.

Contact Tl Support

education.ti.com/ti-cares

Select your country for technical and other support resources.
Service and Warranty Information

education.ti.com/warranty

Select your country for information about the length and terms of the warranty or
about product service.

Limited Warranty. This warranty does not affect your statutory rights.
Texas Instruments Incorporated

12500 TI Blvd.

Dallas, TX 75243
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